
 Model 900M  -  Instruction Manual
(Please refer to the CD for more detailed information)

The Watermark Monitor automatically reads up to eight (8) sensors and
stores the readings for collection and display by a computer.  Watermark soil
moisture, soil temperature, Irrometer Model RSU (4-20mA  transducer),
switch closure, voltage and 4-20mA sensors can be read and recorded.

SENSOR INSTALLATION
Watermark soil moisture sensors must be “conditioned” prior to installation.
The sensors should be soaked to saturation and then dried fully, twice, and
then soaked to saturation again prior to installation.  This “conditioning” of the
sensors ensures quick response to changing soil moisture conditions.  If a
sensor is only soaked and then installed, several irrigation cycles must pass
before the sensor will respond accurately.  Soak the sensors in a bucket of
water for several hours to saturate them.  Hang them up overnight to dry
sufficiently.  After “conditioning” they are ready for  installation.  Sensors
MUST be installed in an active portion of the root zone of the plant to be
monitored, either vertically or up to a 45° angle.  Bore a 7/8” diameter
access hole to the desired depth, then insert the sensor.  Be careful to
ensure a snug fit between the sensor and the surrounding soil.  Then
backfill the hole firmly.  The access hole can be made by pounding a 7/8”
diameter bar (or ½” size IPS pipe) to the desired depth, then extracting
the bar, being careful not to disturb the soil surrounding the borehole.  With
hard or rocky soil, a larger diameter hole can be made with a soil auger.  Mix
the auger cuttings with water to create a slurry and pour into the borehole.
Then insert the sensor into the hole.  Once the slurry dries, the sensor will
have been “grouted” in to ensure good contact with the soil.  The sensor
can be attached to ½” class 315 PVC pipe with a PVC to ABS cement.  The
pipe becomes a conduit to protect the sensor wires.  Also, this makes the
sensor easier to push into the access hole and remove, if desired.  The top
of this pipe section should be capped or plugged so surface water does not
travel down to the sensor.  Drill a small hole in the side of the pipe just above
the sensor to allow water to drain away if it becomes trapped in the pipe.
The soil temperature sensor should be installed in the soil near a
representative soil moisture sensor.  More than one soil temperature
sensor can be used.  Several soil moisture sensor readings can be
compensated by a single soil temperature sensor.  Bore a
1/2” diameter hole in the soil and insert the temperature sensor.  Then
backfill the hole. Refer to Irrometer installation instructions for proper instal-
lation of Model RSU.  The switch closure sensor is a pressure gauge with a
¼” NPT connection that has an adjustable switch mounted to its face.  The
gauge is installed into the irrigation pipeline.  The pressure range of the
gauge should be selected so that the normal system pressure is in the
middle third of the gauge range.  The normal system pressure is the set

point which will trip the switch, indicating that an irrigation is taking place.    #86

WARRANTY:  The IRROMETER COMPANY warrants its products against defective
workmanship or materials under normal use for one year from date of purchase.
Defective parts will be replaced at no charge for either labor or parts if returned to
the manufacturer during the warranty period.  The seller’s or manufacturer’s only
obligation shall be to replace the defective part and neither seller nor manufacturer
shall be liable for any injury, loss or damage, direct or consequential,arising out of
the use of or inability to use the product.  This warranty does not protect against
abuse, shipping damage, neglect, tampering or vandalism, freezing or other damage
whether intentionally or inadvertently caused by the user.

TROUBLESHOOTING
Please reference the suggestions below, look in the Help section of WaterGraph or
contact Irrometer for further assistance.
No Display:  Check battery, replace if <7.2 Volts. Try RESET, see below.
Unusual readings:  The following are possible readings that may be displayed
instead of a soil moisture, temperature or switch position:  DRY- meaning the
resistance is so high that there must be an open wiring connection on a Watemark or a
low temperature reading  (frozen) on a temperature sensor, check for broken wires.
SHORT- meaning the resistance is so low that the circuit must be shorted on a
Watermark, or off scale on a temperature sensor, check for shorts.
Reading doesn’t change:  Sensor may have lost contact with the soil.  Re-install sensor,
being sure to establish good soil contact.
COM Port issues:   Direct serial connection should normally be COM 1 to COM 4.  If a
COM port is available the Autodetect function will find the Monitor.  If a COM port not
available, check to see if a PDA Sync program is active and may be capturing the COM
port.  This is very typical with laptops.  The Palm Hot Sync Manager or the Microsoft
Active Sync Manager icon will appear as active in the lower right side task bar of the
desktop.  Right click on it and select Exit to close it and free up the COM port.  Closing
WaterGraph and re-opening it may help to establish communication with the COM port,
if it is available.  Also, re-starting the computer can clear up COM issues.
Connection with a USB to Serial adapter cable:  These adapters create virtual COM
ports from a USB connection.  The adapter will come with software (drivers) that
must be installed on the computer.  Normally the COM port number created with
these adapters will be COM 5 to COM 8.  The COM address of the adapter can be
determined by navigating to:  My Computer – right click to get Properties –
Hardware – Device Manager.  Then look in the USB or Port sections to see if the
adapter is listed.  Select it and right click to view the properties of the device and it
should show the COM port assigned.
Soft RESET:  Use the end of a paper clip or other small object to press the RESET button
located underneath the small hole just above the battery on the faceplate.
Hard RESET:  Remove the battery.  Press and hold the RESET button down for at
least 5 seconds.  Then re-insert the battery.
Firmware upgrading:  Using the “Update Datalogger” command in the “Tools” menu
in WaterGraph, select the new firmware version (.hex format) and press “Open.”  If
the upload process is interrupted, then Monitor will be locked up and it’s display
will stay on “Uploading.”  If this happens, use the “Recover Monitor Update”
command in the “Tools” menu to finish the upload process.
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MOUNTING
The Monitor housing should be mounted on a wall or post nearby the sen-
sors.  Use the enclosed template to mark screw holes for mounting the
enclosure.  Set the Monitor over the top screw with the “keyhole” then
secure with screws in the lower holes.  Run sensor wires through the strain
relief fittings on the bottom of the Monitor.  Tighten the gland on the fitting
to compress the rubber insert to secure the wires and weather-proof the
enclosure.  The Monitor can be located some distance from the sensors to
facilitate access.  See sensor wiring recommendations below.  If using the
Quick Disconnect version, attach the field sensor wires to the wire tail from
the connector using waterproof wire splices.  Be careful to follow the wire
markings to be sure the sensor wires are attached to their corresponding
terminals.  The quick disconnect fittings will twist apart for easy removal.
SENSOR WIRING
Additional wire can be added to the sensors for long distances.
Please adhere to the following wire size recommendations when adding
wire:     Distance      Wire Size

Up to 1000 ft. (300 m)      AWG UF 18  (1.02 mm, .82 sq mm)
1001 to 2000 ft. (600 m)      AWG UF 16  (1.29 mm, 1.31 sq mm)
2001 to 3000 ft. (900 m)      AWG UF 14  (1.63 mm, 2.08 sq mm)

Multi-conductor wire can be used and twisted pairs are not necessary.  All
splices should be made with direct burial type waterproof splices, Spears DBY®

or similar.  Be sure to mark each pair of sensor wires indicating what type of
sensor is attached and the placement depth. Attach sensor wires to the
appropriate terminals as determined by your sensor selection.  The terminal
strips have spring tensioned lever terminals.   First, insert the wire in the
bottom of the terminal, then push down on the black lever.  The lever can be
lifted with a finger, or small screwdriver inserted in the slot, for wire removal.
Terminals will accept wire up to AWG 16.  If a larger size is used, run a short
length of smaller wire to the terminal strip.

BATTERY INSTALLATION
Insert a 9 Volt battery, connectors first, into the battery holder observing
polarity markings.  Snap the back end of the battery fully into the holder.
An alkaline battery should provide approximately one year of operation.
After the battery is installed, the display shows “Clock Error” and  “Run
Setup.”  After 5 seconds the Monitor display “go to sleep” to conserve
battery power.  Pressing the green button will “wake up” the Monitor.  If
you see “Fault Error #__”, please note the error number and contact the
factory for troubleshooting. An automatic check of the battery capacity is
performed daily.  The status is displayed every time the Monitor is turned
on.  Whenever “LOW” is in the display, it indicates it is time to replace the
battery.  Wait for the display to go to sleep (no display), then replace the
battery within 5 seconds of the display going off, to ensure no loss of data.
Press the button to wake the Monitor up and you should see “Battery OK”
in the display.  If you are using the AC transformer version of the Monitor,
simply plug in the transformer.  The battery will serve as a backup in the case
of a power failure, but must be kept in the Monitor for operation.

MANAGEMENT

The key element in proper soil moisture measurement is the operator. Tak-
ing the time to interpret your sensor readings will give you a vivid picture of
what is happening with the soil moisture in the root system of your crop.
Usually 2 – 3 readings between irrigations is sufficient. The graphical display
of your readings show exactly how quickly (or slowly) your soil moisture is
being depleted.
Use the following readings as a general guideline:

•  0 – 10 centibars = Saturated soil
• 10 – 30 centibars = Soil is adequately wet
   (except coarse sands, which are beginning to lose water)

• 30 – 60 centibars = Usual range for irrigation (most soils)
• 60 – 100 centibars = Usual range for irrigation in heavy clay
• 100 – 200 centibars = Soil is becoming dangerously dry for
   maximum production.  Proceed with caution!

Your own situation may be unique because of differences in crop, soils and
climate. Perhaps the most important soil moisture reading is the difference
between today’s reading and that of 3 – 5 days ago. That is to say, how quickly
is the reading going up. A slow increase means the soil is drying out slowly. But
a big jump means the soil is losing water very rapidly. By analyzing such trends
in the readings, you will determine WHEN to irrigate.   By using sensors at two
or more depths in the root system, you can determine HOW MUCH water to
apply. If the shallow sensor shows a rapidly increasing reading, but the deep
sensor shows adequate moisture, you can run a short irrigation cycle as you
only need to replenish the shallow root profile. If the deep sensor also shows a
dry condition, then a longer irrigation cycle is needed to fully re-wet the entire
root zone. The readings you take after an irrigation or rainfall event will show
you exactly how effective that water application was.  Your own experience
and management will soon point you in the proper direction. You will be
practicing “irrigation to need” with the positive results that come from any
good management program. 2   7

NOTE:  Irrometer Model RSU transducers require a wiring adapter, auxiliary
power and special instructions, please consult factory for advice.

An Irrometer Switching Pressure Gauge can be used for the Switch Closure
sensor input, to record whenever the irrigation system is running.  It stays in
the closed position until the irrigation is turned off, then  returns to the
open position, as pressure in the pipe drops.  This gives you a data-logged
recording of your irrigation system run time.  Be sure to select a Switching
Pressure Gauge with the correct range for the operating pressure of the
irrigation system.  The pressure at which the switch closes should be within
the middle third of the gauge operating range.  For example, if the irrigation
system’s normal operating pressure is 8 p.s.i., then use a gauge with a 0 to
15 p.s.i. range.  Also, be sure your sensor reading interval is relative to your
irrigation system run time.



PROGRAMMING
WaterGraph is a Microsoft Windows®  based software program with which
you communicate with the Watermark Monitor.  With this software, and the
Monitor connected to your computer, either at your desk or in the field, you will
program your individual SETUP characteristics and download collected data to
graphically represent the soil moisture characteristics of your location.   These
functions are outlined in the following steps:
To install the software onto your computer:
(System Requirements:  Win 98 or newer, 5 MB available hardrive space, 12MB RAM)

1  Insert the WaterGraph CD into your computer’s CD drive.
2  The installation program will launch automatically.  If it does not, using
    Windows® Explorer, browse to the CD drive and double click the Setup.exe
    file located on the installation CD.
3  Select “Yes” when prompted to install WaterGraph software.
4  Follow the on screen prompts, selecting “Next” and accepting the default
    choices suggested until reaching the end of the installation.
5  Select “Finish” to conclude the installation.
6  You may now launch WaterGraph by double clicking on the desktop icon.
To program the sensor/reading configuration you want (SETUP):
1  Connect the Watermark Monitor to your Windows® based (PC) computer
    (laptop or desktop) with the supplied serial cable.  One end connects to
    the Monitor at the port labeled “Serial Port” and the other end connects to
    one of the COM ports on your computer, or through a USB to serial adapter.
2  Double click the WaterGraph icon on your desktop to open the program.
3  The first window you will see may say “Choose Language.”  If so, select the
    language you wish to use.  This can later be changed in the File pull down
    menu, but the program must be re-started to take effect.
4  The next window you see says “Auto Detect.”  This window prompts you to
    allow the program to locate the correct COM port on your computer or
    allows you to select the appropriate port.  Click either “Auto Detect” or
    select the COM port from the drop down list and click “Done.”
5  Once the computer has connected with the Monitor, the main program
    window will open which says “WaterGraph.”
6  Select “Setup Datalogger.”  This will open the Setup window where you
    input characteristics with which you want your Monitor to take readings.
7  First, enter a specific name in the space provided after Datalogger Name:
    (16 alphanumeric characters available using spacebar for blank spaces).
8  Then click on the pull down menu arrow in the box labeled “Read Interval.”
    Here you select the interval with which the Monitor will automatically read
    the sensors.  Note that next to each choice of reading intervals, the
    approximate capacity of readings is displayed in parentheses.
9  If you are using a soil temperature sensor, skip this step.  If you want the
    Monitor to be programmed with a default soil temperature, which will
    compensate the Watermark readings, then input that value in the space
   provided and pick either “F” for Fahrenheit or “C” for Centigrade scale.
10 Next, proceed to the pull down menu for “Sensor 1.”  Here you will
   select which type of sensor this port is connected to, from the

FIELD OPERATION
With the SETUP programmed and the sensors connected, your Watermark
Monitor can now be used to read soil moisture tensions at any time, as well
as the preprogrammed times it is recording data automatically.  Once the
START DATE/TIME has been reached, the Monitor will begin its automatic
reading and data collection.  You may take manual readings of the sensors
at any time.  Simply push the green button once to “wake up” the Monitor.
The display will show the name you assigned, firmware version and the
battery status.  A second push shows the  current date and time on line 1.
If the start time has not yet been reached, the start time will be
displayed on line 2.  If running, the records stored to date will display.  Push
the green button again to read sensor input port number 1.  Each
successive push of the green button will reveal another reading, in
sequence through to port 8.  The in-field display screen shows the sensor
name, type and current reading.  After 10 seconds of inactivity, the Monitor
display will go into sleep mode, to preserve battery life. Taking in-field manual
readings will not alter the automatic readings, nor will they be added in to
the sequence of readings being stored.  Such manual readings can aid in
making on the spot irrigation scheduling decisions, while the stored data is
used to view the rate of change over time and to evaluate the performance
of irrigations which have taken place.

SENSOR SELECTION

The Monitor comes with seven Watermark soil moisture sensors (200SS-15)
and one Soil Temperature sensor (200TS) (Your Monitor may have been
ordered with a different sensor combination).  Any of the sensor input ports
can be configured to be a Watermark, Soil Temperature, Irrometer Model RSU
transducer, Switch Closure, 4-20 mA or voltage sensor.  If all eight ports are
Watermarks, then the default soil temperature setting for compensating soil
moisture readings will be what is programmed in the SETUP screen, for
example 75°F (24°C).  The temperature setting is used to compensate the
Watermark soil moisture sensor readings for varying soil temperatures, since
temperature affects the accuracy of the reading.  If a temperature sensor is
used, then that sensor’s reading is used for the Watermark compensation.
Install the temperature sensor on sensor input port #1, then it will compensate
all Watermark sensors installed after it.  Or compensate sensors differently:

    36



     choice of:  Temp F, Temp C, Watermark, Switch Closure, RSU calibration
    (16, 32, or 93), Volts, 4-20mA or Off.  If you will be using a soil
     temperature sensor, then it should be installed on Port 1.  Refer to
  Sensor Selection on page 6 for additional information.
11  In the space next to the Sensor choice, you will see “Name.”  In the
     empty box next to “Name,” type in a site specific name to identify this
      sensor location (you have up to 8 alphanumeric characters available).
12  Proceed through all 8 ports, selecting “Off” for any unused ports.
13  The date and time is automatically retrieved from your computer’s clock.
14  Now the starting time needs to be set.  If you select “Now,” the time
      will automatically be set.  If you select “Other,” then you will need to
     input the date and time when you want the readings to commence.
      This will allow the Monitor to begin taking readings at a future date.
15  Your SETUP characteristics can be saved with the “Save Datalogger
     Setup” choice from the File menu, for programming multiple units.
16  When you are finished, click on “Send Setup to Datalogger.”  This
      launches or transfers your configuration to the Monitor’s memory.
17  Click “OK” when the pop up window says data collection successful and
     unplug the serial cable.
To view the setup program in the Monitor’s memory at anytime:
1  Connect as previously described and elect “Retrieve datalogger setup” to
view the configuration.  This may take a minute to establish a connection.
To retrieve collected readings (data) from the Monitor (Download):
1  Connect as described and select “Retrieve Data” (PDA, radio and cellular
    telemetry options are available).
2  In the lower left corner of the window you should see the bytes of data
    counting as they are being downloaded.
3  Once this counting has finished, a window will open asking you whether
     you want to erase the Monitor’s memory of this data, or leave it there.
4  Make your selection about the data.  Any old data in the Monitor’s memory
    will be overwritten with new data, once it runs to capacity.  When you
    select to delete the data from the monitor’s memory, a backup file (.bak)
     will be created. (The backup file is saved as a hidden file.  To view you must
    select to view “All Files” when searching.)
5  The program will prompt you to create a file name for the data which has
    been collected.  Additional data which is downloaded at a future date can
    be appended to this same file to create a continuous record.  You do not
    need to save a different file each time you download, simply select the
    existing file and the new data will be added, or appended, to it.
    PLEASE NOTE:  The Save window will tell you that the existing data in that
    file will be erased - but it will NOT.  WaterGraph will only add the new data
    and not replace the old data.
6  The graphing portion of the program will open automatically.
To view the collected data in graphical form (open an existing file):
1  Select “Open Data File” and then select the file you want to view.
2  A window will open showing the data on a graph.  Time is displayed
   along the bottom axis.  Centibars of tension is on the left side axis.
   Temperature, and other scales, are displayed on the right side axis.  5

3  You can change the time scale by selecting one of the default choices or
    entering a value and pressing the “Set Number of Days” button.
    Move the sliding bar at bottom to view all areas of the graph.
4  If “Standard Range” is selected under Centibar Scale, then the Y axis for
    tension readings will be limited to 0 - 100 centibars (kilopascals).  This can
    be manually overwritten in the boxes which show the 0 and the 100 to any
    scale between 0 to 200.  If you select Automatically Scale, then the range
    will be from the lowest to the highest readings in the file.  Changing the
    range can help you zoom in on portions of the graph for better detail.  The
    scale can be reversed by selecting the “Descending Scale” box.
5  Similarly, the ranges for Temperature can be selected.  Also “Hide Temp
    Scale” can be selected if you do not want to show temperature data.
6  The background for the graph can be configured using the “Background”
    menu.   Colors or black & white with line identifiers can be selected.  Also
    options for gridlines and On/Off switch data display are available.
7  The data in the display can be printed by selecting Print from the choices in
    the “File” pull down menu. Selecting Landscape format in your printer’s
    setup will provide a larger printed graph.
8  The graph can also be saved to your computer’s clipboard by holding down
     the “Alt” key and then pressing the “Print Screen” key.  Once it is saved onto
    the clipboard, you can Paste it into another program.
9  Individual graph lines can be turned on and off by selecting “Show” and
   “Hide” in the legend.  They can also be highlighted bold by clicking on the
    color bar in the legend, or left and right clicking directly on the graph lines.
10 Selected sensors may be averaged by selecting them individually in the
     “Average” box in the legend and then clicking “Apply Average Settings.”
     Selecting “Hide sensors included in averages” will display only the average.
11 Threshold lines can be shown on the graph for “too wet”and “too dry”
     reference points.
12 Your viewing options can be saved under File: Save Graph Layout.  This
     way every time you open a data file, it will appear with your saved format.

13 You will notice as you move the curser, that crosshair lines give you
    references to both axis.  In addition, when the curser is close to a graphed
   line, the date/time and value will be displayed for that position in the
   boxes labeled “Crosshair Position.”  Note that you have to select the
   sensor type in the Date/time box to obtain the appropriate value.
To view the collected data in spreadsheet form:
1  Open a spreadsheet program, such as Microsoft Excel®.
2  Open the saved data file.  This has the file extension .CSV, for Comma
    Separated Value.  Be sure to select “All Files” when looking.

3  Excel® will automatically import the CSV data into columns.  Note the

    headings will not line up directly with the data columns, so you will have to
    move them, or create new labels.
4  You can create custom graphing in Excel® to display the data in different
    formats, or in combination with other data.
Note:  You can communicate with the Watermark Monitor through terminal
emulation programs, such as Microsoft® HyperTerminal®, to set up custom
reading programs.  Contact Irrometer for more information. 4


